LENESANS Release Note

RZ/N2H Group

Dual Encoder sample program

Summary
This document describes the RZ/N2H Dual Encoder sample program package.

For EnDat 2.2 communication protocol specifications and encoder specifications (EQN1035), contact
HEIDENHAIN GmbH.

Functionality Checked Device
RZ/N2H Evaluation Board (RTKORZN2HxxxxxxxxX)
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RZ/N2H Group Dual Encoder sample program

1. Package Contents

This package contains the following contents.

The RZ/N2H encoder interface supports up to 13 axes, but the sample program uses a total of 2 axes, with
one axis using A-format and one axis using EnDat. If you use with 3 or more axes simultaneously, modify the
sample program to support required axes.

This sample program operation was checked with an A-format Ver.2.0 encoder in a one-to-one connection
configuration. Operation with bus connection encoder is not checked. Operation with A-format Ver.1.0

encoder is not supported.

1.1 Software
e Source code

No. Name Version number
1 RZ/N2H Dual Encoder sample program (CR52 ver.*) 4.0
2 RZ/N2H Dual Encoder sample program (CA55 ver.*) 4.0

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Documents

No. Document name Version File name
1 RZ/N2H Group Dual Encoder 4.00 (j) r11an0999j0400-rzn2h.pdf
sample program Release Note (e) r11an0999e€j0400-rzn2h.pdf (this document)
2 RZ/N2H Group Dual Encoder 4.00 (j) r11an0998ij0400-rzn2h-dual.pdf
sample program Application (e) r11an0998€j0400-rzn2h-dual.pdf
Note
R11AN0999EJ0400 Rev.4.00 Page 2 of 15
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RZ/N2H Group Dual Encoder sample program

2. File Structure

The file structure and contents of this package are detailed below.

Top

— r11an0999jj0400-rzn2h.pdf

F— r11an0999ej0400-rzn2h.pdf

L— workspace

— Software

— iccarm
| | —RZ N2H_CR52 dual.zip
[
| | L— RZ_N2H_CA55_dual.zip
| |
| ——gcc
| F— RZ_N2H_CR52_dual.zip
|
|
|

|
— RZ_N2H_CAS55_dual.zip

: RZ/N2H Dual Encoder sample program set
CR52 ver. (IAR)

: RZ/N2H Dual Encoder sample program set
CA55 ver. (IAR)

: RZ/N2H Dual Encoder sample program set
CR52 ver. (e? studio)

: RZ/N2H Dual Encoder sample program set
CA55 ver. (e? studio)

L— Documents
— r11an0998jj0400-rzn2h-dual.pdf
L— r11an0998ej0400-rzn2h-dual.pdf

The file structure of the RZ_N2H_CR52_dual.zip and RZ_N2H_CA55_dual.zip is shown below.
Top folder
— configuration.xml
— ( Build Tool Dependent Environment File )

: FSP Configuration data

L—src
F— hal_entry.c : Dual Encoder sample program
F— dual_main.c : Dual Encoder sample program
— siochar.c : SCI_UART sample program
— syscalls.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L—drv

—a_ as

| — iodefine_a_as.h
| F—r_a as rzt2.c

| —r_a_as_rzt2_config.h
| —r_a_as_rzt2_dat.h

\ —r_a_as_rzt2_if.h

\ —r_a_as_rzt2_private.h
| L— a_format
|

|

|

: A_AS register definition file
: A_AS driver file
: A_AS driver file
: A_AS driver file
: A_AS driver file
: A_AS driver file

F—r_a_format_rzt2.c : A-format driver file
—r_a_format_rzt2_config.h : A-format driver file
L—r_a_format_rzt2_private.n : A-format driver file

— iodefine_endat.h
F—r_endat_rzt2.c
—r_endat_rzt2_config.h
—r_endat_rzt2_dat.h
L—r_endat_rzt2_if.h

: EnDat register definition file
: EnDat driver file
: EnDat driver file
: EnDat driver file
: EnDat driver file

R11ANO999EJ0400 Rev.4.00
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RZ/N2H Group

Dual Encoder sample program

3. About Dual Encoder Sample Program

This section contains information necessary to use the complete set of Dual Encoder sample program.

3.1

3.1.

This sample program is OS-independent.

Software Information

1 Base OS

3.1.2 Memory Size

The memory size used by this sample program, the A-format driver, and the EnDat driver is shown in the
following table. This table does not include the memory size used by the Flexible Software Package or the

compiler’s C language libraries.

(1) CR52 ver.
ltems Memory Size
EWARM e? studio
[kBytes] [kBytes]
A-format driver Code 54 3.9
Data (with initial value) 0.0 0.0
Data (without initial value) 6.1 6.1
Constant Data 0.3 0.2
EnDat driver Code 5.6 3.8
Data (with initial value) 0.0 0.0
Data (without initial value) 0.8 0.8
Constant Data 0.3 3.3
Sample program Code 6.5 7.2
Data (with initial value) 0.1 0.0
Data (without initial value) 0.9 0.9
Constant Data 3.1 0.2
(2) CADb55 ver.
ltems Memory Size
EWARM e? studio
[kBytes] [kBytes]
A-format driver Code 8.1 6.4
Data (with initial value) 0.0 0.0
Data (without initial value) 6.7 6.8
Constant Data 04 04
EnDat driver Code 8.6 59
Data (with initial value) 0.0 0.0
Data (without initial value) 1.0 1.0
Constant Data 04 4.1
Sample program Code 9.9 12.7
Data (with initial value) 0.2 0.0
Data (without initial value) 0.9 1.0
Constant Data 3.4 0.3
R11AN0999EJ0400 Rev.4.00 Page 4 of 15
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RZ/N2H Group Dual Encoder sample program

3.2 Hardware Information
3.2.1 Device
RZ/N2H

3.2.2 Target Board
(1) Board Name

RZ/N2H Evaluation Board (RTKORZN2HXXXXXXXXX)

(2) Setting of Target Board
The target board configuration is as follows. Do not push SW4 while using channel AFMT14 / ENDAT_CH14.
DSW2-4: ON, DSW2-6: OFF
DSW5-1: OFF, DSW5-2: OFF, DSW5-7: OFF, DSW5-8: OFF
DSW7-1: OFF, DSW7-2: ON, DSW7-3: OFF, DSW7-4: ON
DSW12-5: ON, DSW12-6: OFF, DSW12-7: ON, DSW12-8: OFF
DSW13-1: OFF, DSW13-2: ON, DSW13-3: OFF, DSW13-4: ON, DSW13-7: ON, DSW13-8: OFF
DSW18-5: OFF, DSW18-6: ON
DSW19-3: OFF, DSW19-4: ON
DSW20-1: OFF, DSW20-3: OFF, DSW20-5: OFF
DSW21-2: OFF, DSW21-3: ON, DSW21-4: OFF, DSW21-5: ON, DSW21-6: OFF
DSW3-1: ON, DSW3-2: OFF, DSW3-3: ON, DSW3-6: OFF (Set xSPI1 boot mode)
JP8: Short between 2-3 pins (Set VDD1833_2 to 3.3 V)
JP9: Short between 2-3 pins (Set VDD1833_3 to 3.3 V)
JP23: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833 6 to 3.3 V)

(3) Used Pin for Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as
follows. Channels AFMT8 / ENDAT_CHS8, AFMT12 / ENDAT_CH12 and AFMT15 / ENDAT_CH15 are not
available.

Channel Pin Name Pin Input/ Voltage Description
Header Output Domain

AFMTO / ENDAT_CHO ENCIFCKOO0 *2 | CN44 #3 | Output VDD33 Clock output
ENCIFOEOO CN44 #5 | Output VDD33 Data output enable
ENCIFDOO00 CN44 #7 | Output VDD33 Data output
ENCIFDIOO CN44 #9 | Input VDD33 Data input

AFMT1 / ENDAT_CH1 ENCIFCKO1 *2 | CN44 #2 | Output VDD1833_5 | Clock output
ENCIFOEO1 CN44 #4 | Output VDD1833_5 | Data output enable
ENCIFDOO01 CN44 #6 | Output VDD33 Data output
ENCIFDIO1 CN44 #8 | Input VDD33 Data input

AFMT2 / ENDAT_CH2 *1 ENCIFCKO02 *2 | CN43 #25 | Output VDD33 Clock output
ENCIFOEO02 CN43 #27 | Output VDD33 Data output enable
ENCIFDO02 CN43 #21 | Output VDD33 Data output
ENCIFDIO2 CN43 #23 | Input VDD33 Data input

R11AN0999EJ0400 Rev.4.00 Page 5 of 15
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RZ/N2H Group

Dual Encoder sample program

Channel Pin Name Pin Input/ Voltage Description
Header Output Domain

AFMT3 / ENDAT_CH3 *! ENCIFCKO3 *2 | CN43 #16 | Output VDD1833_6 | Clock output
ENCIFOEOQ3 CN43 #18 | Output VDD1833 6 | Data output enable
ENCIFDO03 CN43 #22 | Output VDD1833_6 | Data output
ENCIFDIO3 CN43 #24 | Input VDD1833_6 | Data input

AFMT4 / ENDAT_CH4 * ENCIFCKO4 *2 | CN44 #21 | Output VDD33 Clock output
ENCIFOE04 CN44 #23 | Output VDD33 Data output enable
ENCIFDO04 CN44 #25 | Output vDD33 Data output
ENCIFDIO4 CN44 #27 | Input VDD33 Data input

AFMT5 / ENDAT_CH5 *1 ENCIFCKO5 *2 | CN43 #8 | Output VDD1833_6 | Clock output
ENCIFOEO05 CN43 #10 | Output VDD1833_6 | Data output enable
ENCIFDO05 CN43 #12 | Output VDD1833_6 | Data output
ENCIFDIO5 CN43 #14 | Input VDD1833_6 | Data input

AFMT6 / ENDAT_CH6 *! ENCIFCKO06 *2 | CN42 #12 | Output VDD1833_3 | Clock output
ENCIFOEO06 CN42 #14 | Output VDD1833_3 | Data output enable
ENCIFDOO06 CN42 #16 | Output VDD1833_3 | Data output
ENCIFDIO6 CN42 #18 | Input VDD1833_3 | Data input

AFMT7 / ENDAT_CH7 *! ENCIFCKOQ7 *2 | CN42 #22 | Output VDD1833_3 | Clock output
ENCIFOEQ7 CN42 #24 | Output VDD1833 3 | Data output enable
ENCIFDOO07 CN42 #34 | Output VDD1833_3 | Data output
ENCIFDIO7 CN42 #36 | Input VDD1833_3 | Data input

AFMT9 / ENDAT_CH9 *! ENCIFCKO09 *2 | CN51 #12 | Output VDD1833_2 | Clock output
ENCIFOEQ9 CN51 #14 | Output VDD1833 2 | Data output enable
ENCIFDO09 CN51 #16 | Output VDD1833_2 | Data output
ENCIFDIO9 CN51 #18 | Input VDD1833_2 | Data input

AFMT10 / ENDAT_CH10 *' | ENCIFCK10 *2 | CN51 #21 | Output VDD1833_2 | Clock output
ENCIFOE10 CN51 #23 | Output VDD1833 2 | Data output enable
ENCIFDO10 CN51 #25 | Output VDD1833_2 | Data output
ENCIFDI10 CN51 #27 | Input VDD1833_2 | Data input

AFMT11/ENDAT_CH11 *' | ENCIFCK11 *2 | CN51 #20 | Output VDD1833_2 | Clock output
ENCIFOE11 CN51 #22 | Output VDD1833_2 | Data output enable
ENCIFDO11 CN51 #24 | Output VDD1833_2 | Data output
ENCIFDI11 CN51 #26 | Input VDD1833_2 | Data input

AFMT13 / ENDAT_CH13 *' | ENCIFCK13 *2 | CN43 #26 | Output VDD1833_6 | Clock output
ENCIFOE13 CN43 #28 | Output VDD1833_6 | Data output enable
ENCIFDO13 CN43 #30 | Output VDD1833 6 | Data output
ENCIFDI13 CN43 #32 | Input VDD1833_6 | Data input

AFMT14 / ENDAT_CH14 *' | ENCIFCK14 *2 | CN42 #27 | Output vDD33 Clock output
ENCIFOE14 CN42 #31 | Output VDD33 Data output enable
ENCIFDO14 CN42 #33 | Output VDD33 Data output
ENCIFDI14 CN42 #35 | Input VDD33 Data input

Note: 1. The pins are not used in the initial channel configuration. When the channel used is changed, the
corresponding pin header is used.
Note: 2. In A-format, the clock pin ENCIFCK is not used.

R11ANO999EJ0400 Rev.4.00
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RZ/N2H Group

Dual Encoder sample program

3.3 Procedures for Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN27.
Select higher-numbered port from COM ports that appear when connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Order of transmission / reception LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-12
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_N2H_CRS52_dual.zip and copy the extracted source files to the desired location.
Activate EWARM.

2

3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_N2H_dual.eww.

5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds an item to launch FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify the strings shown in the table for each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

The string for the command is a variable that holds the path to the Smart Configurator execution file,
rasc.exe.

If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11ANO999EJ0400 Rev.4.00 Page 7 of 15
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RZ/N2H Group Dual Encoder sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rz,
rz_cfg, rz_gen, script, and .settings folders will be generated.

8 CA1_Prog\Work\Work_C\Wark_EWA_060_3_fsp4.0.0\RZN2H_Dual release_chk - FSP Smart Configurator = (] X

) £l &

File Window Run Help

48 RZN2H_Dual release chk] FSP Configuration X iy “% FSP Visualization =g

Summar o = » 5
Y Generate Project Content L] ‘

Project Summary

RENESAS
Board: RZN2H Evaluation Board (RAM execution without flash memory)
Device: RSADSGOBTMA4GBG
Core: CR52CPUO
FSPVersion: 4.0.0
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_960_3_fsp4.0.0/RZN2H_Dual_release_chk |
Selected software components
Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RZN2H Evaluation Board Support Files {(RAM execution without flash memory} v4.0.0
Memory Config Checking v4.0.0 -
3|26
Support
Summary | BSP | Clocks | Pins| Interrupts| Event Links | Linker Sections | Stacks| Components iy
[E] Properties [£] Problems M & = 8 ECnsole =08

No consoles to display at this time.

Properties are not available.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild All] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_N2H_dual.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.15.10 console commands in the RZ/N2H Group Dual Encoder Sample Program Application Note.

¥ COM10 - Tera Term VT = m] X
JrAWF REE) BEES) IZRO-LO) YEIW) ALTH)
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RZ/N2H Group Dual Encoder sample program

3.3.3 e? studio from RENESAS
(1) Build Environment
RENESAS e? studio 2025-12
Toolchain version: GNU Arm Embedded 13.3.1.arm-13-24

RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.60

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_N2H_CR52_dual.zip and copy the extracted source files to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing Projects into Workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy projects into workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

Q RZN2H_Dual_release_chk - &* studio = [m] x
File Edit Source Refactor Mavigate Search Project RenesasViews Run Renesas 365 Window Help

‘ R i o it @ v Q, &) NotConnected : [ | Fg C/c++
Praject Explorer = 8 = B  Outline x =08 =

= <§> 7 8 There is no active editor that 'Zfo:i'

~ 15 RZ_N2H_dual [Debug] provides an outline.

> [l Includes
ol

i2¢ configuration.xml
e ———Te F

v

= i LI

%| RZ_N2H_dual.elflaunch

> () Developer Assistance . -
Problems Consale Properties Smart Browser Smart Manual g = 0

0 errors, 11 warnings, 0 others

Description . Resource Path Location Type

» & Wamings (11 items)

& configuration.xml - RZ_N2H_dual

R11ANO999EJ0400 Rev.4.00 Page 9 of 15
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6 Click Generate Project Content in the FSP Configuration pane of e2 studio.
The rz, rz_cfg, rz_gen, script, and .settings folders are generated.

8 RZNZH_Dual_release_chk - RZ_N2H_dual/configurationaml - € studio

File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas365 Window Help
® K- it @~ Q, & NotConnected : [
Project Explorer % = [ [RZ_N2H_dual] FSP Configuration 3 =l Outiine 5 =8
= 7 8 > OR A @
¢ - Summary Generat PU + Content S @
~ [ RZ_N2H _dual Encrachojectisonten! There is no active editor that |
&1 Includes

provides an outline.

& src Project Summary )
Renesns
| RZ_N2H_dual.elfjlink Board RZN2H Evaluation Board (RAM execution without flash memory)
X| RZ_N2H dualelflaunch | Device: RIADSGOBTMA4GBG
() Developer Assistance Core: CR52 CPUO
Toolchain: GCC for Renesas RZ
Toolchain Version: 13 3.1 arm-13-24
FSP Version: 400
Project Type: Flat
Location: C:M1_Prog/Work/Weork_C/Work_E2S_RZ..ZN2H_Dual_release_chk/RZ_N2H_dual o

Selected software components

Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RZN2H Evaluation Board Suppert Files (RAM execution without flash memory)
Memory Config Checking

)EO

Summary | BSP | Clocks| Pins | Interrupts | Event Links | Linker Sections | Stacks | Components

Problems % Console Properties Smart Browser Smart Manual i =8
0 errors, 11 warnings, 0 others
Description - Resource Path Location Type
% Warnings (11 items)

7 Select [Project] menu -> [Build All]
The file Debug\RZ_N2H_dual.elf is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading the program to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.15.10 console commands in the RZ/N2H Group Dual Encoder Sample Program Application Note.

1 COM10 - Tera Term VT - u] X
: S} IVRO-IL0)  HVESW) ALTH)
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3.4 Procedures for Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN27.
Select lower-numbered port from COM ports that appear when connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Order of transmission / reception LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H_ N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-12
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_N2H_CA55_dual.zip and copy the extracted source files to the desired location.
Activate EWARM.

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ N2H_CA55 0_dual.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b wON

Note: The following procedure adds an item to launch FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify the strings shown in the table for each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

The string for the command is a variable that holds the path to the Smart Configurator execution file,
rasc.exe.

If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11ANO999EJ0400 Rev.4.00 Page 11 of 15
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RZ/N2H Group Dual Encoder sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rz,
rz_cfg, rz_gen, script, and .settings folders will be generated.

C\1_Prog\Work\Wark C\Work_EWA_060_3_fspd.0.0RZN2H_Dual_CASS_release_chk - FSP Smart Configurator = (] X

File Window Run Help

45 RZN2H_Dual CASS release chk] FSP Configuration ¥4, FSP Visualization =g

Summar o = » 5
Y Generate Project Content L] ‘

Project Summary

RENESAS
Board: RZN2H Evaluation Board (RAM execution without flash memory)
Device: RSADSGOBTMA4GBG
Core: CAS5 Cored
FSPVersion: 4.0.0
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_96...4.0.0/RZN2H_Dual_CA55_release_chk 4|
Selected software components
Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RZN2H Evaluation Board Support Files {(RAM execution without flash memory} v4.0.0
Memory Config Checking v4.0.0 -
3|26
Support
Summary | BSP | Clocks | Pins| Interrupts| Event Links | Linker Sections | Stacks| Components iy
[0 Properties [2] Problems M & = B8 EConsle -f-=8

No consoles to display at this time.

Properties are not available.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild All] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_N2H_CA55 0_dual.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.15.10 console commands in the RZ/N2H Group Dual Encoder Sample Program Application Note.

¥ COM10 - Tera Term VT = m] X
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RZ/N2H Group Dual Encoder sample program

3.4.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2025-12
Toolchain version: GCC Arm A-Profile (AArch64 bare-metal) 13.2.1.20231009
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.60

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_N2H_CA55_ dual.zip and copy the extracted source files to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing Projects into Workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy projects into workspace, and click [Finish].
5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.
ﬁ RZM2H_Dual CAS5_release_chk - € studio = (m] X |
File Edit Source Refactor Mavigate Search Project RenesasViews Run Renesas 365 Window Help
| @v%v | o fy v @~ Q &Notionnected ﬁl g crcs+
Project Explorer ¢ = 8 = O  Outline x = 8 g

=R =T There is no active editorthat  (§3)
v [z RZ_N2H_CAS55_0_dual [Debug] provides an outline.

» [ajf Includes
pel
LR e erlink
X| RZ_M2H_CAS5 0 dual.elflaunck
» (2) Developer Assistance

=
I
]

Problems ¢ Consale Properties Smart Browser Smart Manual

0errors, 11 warnings, 0 others
-
Description Resource Path Location Type

» & Warnings (11 items)

i,"J-:f configuration.xml - RZ_N2H_CAS5_0 dual
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6 Click Generate Project Content in the FSP Configuration pane of e2 studio.
The rz, rz_cfg, rz_gen, script, and .settings folders are generated.

{8 RZN2H_Dual_CASS_release_chk - RZ_N2H_CAS55_0_dual/configuration.xml - & studio - ] x
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas365 Window Help
&~ LR R g Q| &Y Not Connected | [
Project Explorer 3 = B § [RZ_N2H_CAS5_0_dual] FSP Configuration % e Outine X [ 14 A = 5
E= g Summary (5] There is no active editor that @]
~ g5 RZ_N2H_CAS5 0 dual Generate Project Content | provides an outline.
@) Includes
(3 src Project Summary )
enesas
RZ_N2H_CAs55_0_dual.elfjli Board RZN2H Evaluation Board (RAM execution without flash memory)
| RZ_N2H_CAS5 0 dualelila | Device: RYADSGOBTM44GBG
(%) Developer Assistance Core: CAS5 Corel)
Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
Toolchain Version: 13.2.1.20231009
FSP Version: 400
Project Type: Flat
Location: C:/1_Prog/VorkiWork_C/\Work_E2S_RZ...55_release_chk/RZ_N2H_CA55_0_dual =]
Selected software components
Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RZN2H Evaluation Board Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0 -
o ¥5) ¢ |
| Support
|
: Summary | BSP | Clocks | Pins| Interrupts | Event Links | Linker Sections | Stacks | Components
=0

Problems X Console Properties Smart Browser Smart Manual
Oerrors, 11 warnings, 0 others
Description Resource Path Location Type

5 Warnings (11 items)

7 Select [Project] menu -> [Build All]
The file Debug\RZ_N2H_CA55 0_dual.elf is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading the program to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.15.10 console commands in the RZ/N2H Group Dual Encoder Sample Program Application Note.
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Revision History

Description
Rev. Date Page Summary
2.00 Mar.28.25 - First Edition issued.
3.00 Nov 28.25 2,3 Update revisions of the application note and the release note.
Update sample program version to 3.0. (Support FSP v3.0.0.)
4 Update memory size information.
7to 14 Update build environment for FSP v3.0.0. Figures are replaced.
4.00 May 15.26 2,3 Update revisions of the application note and the release note.
Update sample program version to 4.0. (Support FSP v4.0.0.)
Update file structure.
4 Update memory size information.
6 Correct AFMT13/ENDAT_CH13 pin assignment.
7to 14 Update build environment for FSP v4.0.0. Figures are replaced.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

- A-format is a trademark of Nikon Corporation.

- EnDat is a registered trademark of Dr.Johannes Heidenhain GmbH.

« J-Link is a trademark of SEGGER Microcontroller GmbH.

- IAR Embedded Workbench is a registered trademark of IAR Systems.

- Arm is registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere. All rights
reserved.

- Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2026 Renesas Electronics Corporation. All rights reserved.
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